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Project 10: Combined Brochure

Stage 2 Working with Linked Files

Adobe InDesign supports a variety of graphics formats. Your ultimate output goal will determine the 

specific type of graphics used in a particular job. For print applications such as the brochure you’re 

building in this project, you should use high-resolution raster image files or vector-based graphics files. 

Depending on what type of file you are importing, you have a number of options when you place 

a file. This stage of the project explores the most common file formats for print design workflows.

Replace a Native illustRatoR File

As part of the Adobe Creative Suite, InDesign supports native Adobe Illustrator files 

(with the “.ai” extension) that have been saved to be compatible with the PDF format. 

Illustrator files can include both raster and vector information (including type and 

embedded fonts), as well as objects on multiple layers in a variety of color modes 

(including spot colors, which are added to the InDesign Swatches panel when the 

Illustrator file is imported).

 1. With boulevard.indd open, open the Links panel.

The file blvd logo.ai has been placed three times, but the file has been modified since it 

was placed. Remember from Project 9: HeartSmart Newsletter, that placed files need to 

be present and up to date for the file to output properly.

 2. On Page 1 of the layout, use the Direct Selection tool or the Content 

Grabber to select the placed graphic with the Modified warning icon.

When you select a specific instance of a file that has been placed multiple times, the item 

expands in the Links panel and the selected instance is highlighted.

 3. Open the Transform panel (Window>Object & Layout>Transform).

The options in the Transform panel are the same as those on the left side of the 

Control panel. As you can see, the selected graphic is scaled to approximately 62% 

proportionally.

The placed instance is 

scaled to approximately 

62% proportionally.

Only the selected 

instance is highlighted.

 4. In the Links panel, click the main listing for the blvd logo.ai file and then 

click the Update Link button.

By selecting the main item listing instead of a specific instance, you update all instances 

of that file at one time. If you want to update individual instances, you can use the 

Modified warning icons on the page, or select only the specific instance in the panel and 

click the Update Link button.

Select the main 

item to update all 

instances at once.

Update Link button

Make sure you select the 

content inside the frame 

and not the actual frame.

Note:

3333project
Identity Package
Your client, Graham Apple, owns an 

organic orchard in Central Florida. 

He hired you to create a corporate 

identity package so he can begin 

branding his products to reach a 

larger consumer base in gourmet 

groceries throughout the Southeast. 

He asked you to develop a logo, and 

then create the standard identity 

pieces (letterhead and envelope) that 

he will use for business promotion 

and correspondence. 

� is project incorporates the following skills:

� Developing custom logo artwork based on an 

object in a photograph

� Using a gradient mesh to create realistic color blends

� Converting type to outlines and manipulating letter 

shapes to create a � nished logotype

� Using layers to easily manage complex artwork

� Creating multiple artboards to contain speci� c 

projects and layouts

� Building various logo versions to meet speci� c 

output requirements

� Saving EPS � les for maximum � exibility

� Printing desktop proofs of individual artboards
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Project Meeting
� e Chateau is a unique destination restaurant 
that consistently wins awards from local 
and national food and wine reviewers. � e 
restaurant was � rst opened in 1952 by Paul 
and Gina Roseman as a rest stop and diner for 
travelers along the Sierra Highway. While the 
restaurant remains in the family, it has evolved 
from home-style comfort food to more exotic 
fare such as wild game with a French twist.

� e history of the restaurant is important to 
us. We have a Roseman family portrait — my 
great-grandparents — that we’d like to include 
on the back of the menu. � e picture is a bit 
grainy and has some damage, though, and we’d 
like you to clean it up as much as possible. We 
also want to include a picture of the current 
executive chef, who is Paul and Gina’s great-
grandniece, in the same section. � e only 
picture we have of her is very dark though, and 
we’re hoping you can make it look better.

In addition, we’ve taken several pictures of 
di� erent meals that Suzanne created. We want 
you to make sure they will look as good as 
possible when printed. You’re the expert, so we 
trust that you know what needs to be done.

Digital images come from a wide variety of 
sources: scanned photographs and digital 
cameras are the two most common, as is the 
case for the client’s images for this project. 
Some images can be used as is, or at least with 
only minor correction. Realistically, most 
professional photographers reshoot an image 
until they have one that doesn’t need your help. 

Unfortunately, however, not every project 
involves a professional photographer. 
Consumer-level cameras have come down 
in price and gone up in quality to the point 
where many non-professionals shoot their own 
photos without proper skill or knowledge. � at 
means many of those images require a bit of 
help — and some require a lot. 

Even when a professional photographer is 
involved, not every image comes from a 
perfectly lit studio. Location shots — where 
a subject is photographed in a “real-world” 
setting — can’t always be captured perfectly. 
� ose images usually need work as well. 
Fortunately, Photoshop provides a powerful 
toolset for solving most image problems, or at 
least improving the worst of them.

To complete this project, you will:

� Remove grain with blur and sharpen 
techniques

� Heal severe scratches

� Clone out major damage

� Correct minor problems with the 
Brightness/Contrast adjustment

� Correct tonal range with the Levels 
adjustment

� Correct lighting problems with the 
Exposure adjustment

� Correct overall color problems with the 
Color Balance adjustment

� Correct precise color values with the 
Curves adjustment

� Correct an RGB image to CMYK 
gamut limits

� Embed color pro� le information in a � le

� Combine multiple exposures with the 
Merge to HDR Pro utility

335Project 6: Menu Image Correction

CorreCt Lighting ProbLems with the exPosure Adjustment

Many images are either over- or underexposed when photographed. If an image is under- 
exposed, it appears dark and lacks detail in the shadows. If an image is overexposed, it 
appears too light and lacks detail in the highlights. You can use the Exposure adjustment 
to correct exposure — and thus, the overall detail and contrast in the image.

Keep in mind, however, that Photoshop cannot create information that doesn’t 
exist. If you have an underexposed image with no detail in the shadow areas, Photoshop 
cannot generate that detail for you. Some problems are simply beyond fixing.

The Exposure dialog box is designed to make tonal adjustments to 32- and 64-bit  
HDR (high dynamic range) images, but it also works with 8-bit and 16-bit images. 
The Exposure adjustment works by performing calculations in a linear color space 
(gamma 1.0) rather than the image’s current color space.

 1. Open chicken.jpg from your WIP>Menu folder.

 2. Choose Image>Adjustments>Exposure and make sure Preview is checked.

Gray Point eyedropper

White Point eyedropper

Black Point eyedropper

 3. Click the White Point eyedropper, and then click the white area on the top 
edge of the plate.

The eyedroppers in the Exposure dialog box adjust the image’s luminance (or the degree 
of lightness, from white to black). By adjusting the luminance only, you can change the 
lightness of the image without affecting the color.

•	 Clicking	with	the	Black	Point	eyedropper	shifts	the	point	you	click	to	black	 
(0 luminance).

•	 Clicking	with	the	White	Point	eyedropper	shifts	the	point	you	click	to	white	
(100 luminance).

•	 Clicking	with	the	Gray	Point	eyedropper	shifts	the	point	you	click	to	gray	 
(50 luminance).

Click here with the White 
Point eyedropper to define 
the white area of the image.

Clicking with the White 
Point eyedropper changes 
the Exposure setting.

HDR refers to  
high-density range  
(32- or 64-bit) images.

Note:

The White Point and 
Gray Point eyedroppers 
affect the Exposure 
value. The Black Point 
eyedropper affects the 
Offset value.

Note:

Walk-Through

Visual Explanations
Wherever possible, screen shots 
are annotated so students 
can quickly identify important 
information.

Step-By-Step Exercises
Every stage of the workfl ow is 
broken into multiple hands-on, 
step-by-step exercises.

Real-World Workfl ow 
Projects are broken into logical lessons or 
“stages” of the workfl ow. Brief introductions at 
the beginning of each stage provide vital foun-
dational material required to complete the task.

Project Goals
Each project begins with a clear description 
of the overall concepts that are explained 
in the project; these goals closely match the 
different “stages” of the project workfl ow.

The Project Meeting
Each project includes the client’s initial 
comments, which provide valuable 
information about the job. The Project 
Art Director, a vital part of any design 
workfl ow, also provides fundamental 
advice and production requirements. 

Project Objectives
Each Project Meeting includes a 
summary of the specifi c skills required 
to complete the project.
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Project Review

 1. Explain the advantages of using a gradient mesh, compared to a regular gradient.

 2. Briefl y explain two primary differences between point-type objects and area-type objects.

 3. Explain the potential benefi ts of using multiple artboards rather than different fi les for different pieces.

 1. The _______________ provide access to 

handles that you can use to manually resize the 

artboard in the workspace.

 2. Press _______________ and click the eye icon 

on a specifi c layer to switch only that layer 

between Preview and Outline mode.

 3. When _______________ are active, moving 

your cursor over an unselected object reveals 

the paths that make up that object.

 4. The _______________ tool is used to sample 

colors from an object already placed in the fi le.

 5. The _______________ is used to monitor and 

change the individual attributes (fi ll, stroke, 

etc.) of the selected object.

 6. The _______________ is the imaginary line on 

which the bottoms of letters rest.

 7. _______________ is the spacing between 

specifi c pairs of letters (where the insertion 

point is placed).

 8. The _______________ command makes the 

vector shapes of letters accessible to the Direct 

Selection tool.

 9. A _______________ is a special ink used to 

reproduce a specifi c color, typically used for 

one- or two-color jobs.

 10. Click the _______________ in the Layers panel 

to select a specifi c sublayer.

464 Project 8: Festival Poster

It’s always a good idea to begin a project as soon as 

possible after getting the assignment. When working with 

clients, however, you will often find that the idea for a 

project comes before the actual content — sometimes long 

before the client has finalized the text. 

Rather than waiting until the client’s content is ready — 

which is sometimes the day before a project is due — you 

can design a layout using placeholders to mark the location 

of pictures and text frames, and even experiment with the 

appearance of different elements of the text.

 With the insertion point placed in a text 

frame, choosing Type>Fill with Placeholder 

Text fills the active text frame with lorem 

text (supposedly from a Latin treatise on 

ethics written by Cicero more than 2000 

years ago) using the default text-format 

settings. If a text frame is linked to other text 

frames, the placeholder text fills the entire 

series of linked text frames.

Lorem placeholder text is valuable for 

experimenting with the appearance of 

paragraph text, giving you a better idea of 

what blocks of copy will look like when real 

content is placed in the layout. 

If you press Command/Control while choosing the Fill 

with Placeholder Text command, you can define a different 

language to use for the placeholder text. These options are 

useful if you want to experiment with a design for a layout 

in which the text does not use the Roman alphabet — 

again, the placeholder more accurately represents what the 

final copy will look like..
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Designing with Placeholder Text

All four threaded text frames are filled with Japanese placeholder text.

All four threaded text frames are filled with Cyrillic placeholder text.

All four threaded text frames are filled with Roman placeholder text.
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Use what you learned in this project to complete the following freeform exercise. 
Carefully read the art director and client comments, then create your own design to meet the needs of the project.
Use the space below to sketch ideas; when fi nished, write a brief explanation of your reasoning behind your fi nal design.

Portfolio Builder Project

� e Sawdust Festival is one of the longest running 
and well-known art shows in California, maybe 
even the entire United States. We’re planning our 
advertising campaign for the 2013 summer.

You might want to poke around our Web site to 
get some ideas. � ere is plenty of information 
about the festival’s history, and many images from 
previous shows. 

We need an ad that will be placed in the pull-
out sections of regional newspapers, and another 
version of the same ad that can go into magazines 
for travel/tourism audiences (like the WestWays 
magazine from AAA). Both ads should be four-
color, although you should keep in mind the basic 
color scheme that we use on our Web site.

� e ads need to have all the relevant text. But just 
as important, we want the ad to be art in its own 
right; the visual element you create will actually be 
repurposed for festival souvenirs like shirts, posters, 
and so on.

� e former marketing director for the Miami 
Jazz Festival recently moved to California 
to become the director of the Laguna Beach 
Sawdust Festival. She was pleased with your 
work on the jazz festival project, and would 
like to hire you to create the advertising for 
next year’s art festival event.

To complete this project, you should:

� Download the Print6_PB_Project8.zip 
archive from the Student Files Web page to 
access the client-supplied text � le.  

� Develop some compelling visual element 
that will be the central focus of the ads.

� Create an ad that � ts on a tabloid-size 
newspaper page (9 1/2 × 11 1/2″ with 
no bleeds). 

� Create a second version of the same ad to 
� t a standard magazine trim size (8 1/4 × 
10 7/8″ with 1/8″ bleeds).

Portfolio Builder Projects
Each step-by-step project is accompanied 
by a freeform project, allowing students to 
practice skills and creativity, resulting in an 
extensive and diverse portfolio of work.

171Project 3: Identity Package

 5. With the mesh object selected, click the Add New Stroke button at the 
bottom of the Appearance panel.

The mesh object now has a 1-pt 
black stroke, which you will see 

more clearly in a moment.

Make sure you are working 
on the Two Color layer.

The Appearance panel now 
shows that the mesh object has 
a defined stroke, using the 
default stroke color and weight.

Add New Stroke

Add New Fill

Add New Effect

 6. With the mesh object still selected, choose Object>Expand Appearance.

This command converts the selected object into separate constituent objects — one 
path for the shape’s stroke attribute and one for the object’s mesh fill — which are 
automatically grouped together. 

 7. In the Layers panel, expand the new group.

 8. Use the Layers panel to select only the mesh object in the group.

Click here to select 
only the mesh object.

Expanding the appearance 
creates separate (grouped) 
objects for each attribute.

In addition to changing 
the existing attributes 
of an object, you can 
also use the Appearance 
panel to compound effects 
and attributes. In other 
words, you can add a 
new stroke to any object, 
including an object that 
already has a defined 
stroke. 

Note:

New appearance 
attributes are created 
on top of the currently 
selected appearance. You 
can drag the appearance 
names in the panel to 
change their stacking 
sequence, which can have 
a significant impact on 
the end result.

Note:

Design Foundations
Additional functionality, related tools,  
and underlying graphic design concepts  
are included throughout the book.

Advice and Warnings
Where appropriate, sidebars  
provide shortcuts, warnings, or 
tips about the topic at hand.

Project Review
After completing each project, students  
can complete these fill-in-the-blank and 
short-answer questions to test their under-
standing of the concepts in the project.

Project Summary

370 Project 6: Menu Image Correction

As with many other skills, it takes time and practice to master image correction techniques. 

Understanding the relationship between brightness and contrast, and how these two values a� ect 

the quality of reproduction in digital images, is the � rst and possibly most critical factor in creating 

a high-quality image. An image that has too much contrast (a “sharp” image) or not enough contrast 

(a “� at” image) translates to an unsatisfactory print. A basic understanding of color theory (speci� cally complementary color) is the foundation 

of accurate color correction. E� ective color correction relies on the numbers, rather than what you 

think you see on your monitor. As you gain experience in correcting images, you will be better able 

to predict the corrections required to achieve the best possible output. 
Remove photographic grain with blur and 
sharpen techniques
Use the Healing Brush and Spot Healing Brush tools to correct scratches

Use the Clone Stamp tool to remove major damage

Correct contrast and tonal range using the 
Levels adjustment

Correct lighting problems with the Exposure adjustment

Use Merge to HDR Pro to find detail in multiple exposures

Correct contrast with the Curves adjustment

Correct gray balance using the Curves adjustment

Correct overall color cast using the Color Balance adjustment

Correct minor color problems using the Brightness/Contrast adjustment

Correct and convert the image using the defined destination CMYK profile

Visual Summary
Using an annotated version of the 

finished project, students can quickly 
identify the skills used to complete 

different aspects of the job.
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 6 Menu Image Correction

o Retouching Damaged Images

o Correcting Lighting Problems

o Correcting Color Problems

o Preparing Images for Print

o Working with HDR Images
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 5 African Wildlife Map

o Working with Vector Shape Layers

o Compositing with 
Smart Objects

o Using Filters and 
Adjustments

o Creating 
an Artistic 
Background

o Outputting Files
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 4 Composite Movie Ad

o Compositing 
Images and 
Artwork

o Managing Layers

o Creating 
Complex 
Selections

o Saving 
Photoshop Files 
for Print
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 3 Identity Package

o Working with Gradient Meshes

o Working with Type 

o Working with 
Multiple Artboards

o Combining Text 
and Graphics
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 2 Balloon Festival Artwork

o Drawing Complex 
Artwork

o Coloring and 
Painting Artwork

o Exporting EPS 
and PDF Files
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 1 International Symbols

o Setting up the Workspace

o Drawing Basic Shapes
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The Against The Clock Portfolio Series teaches graphic 
design software tools and techniques entirely within 
the framework of real-world projects; we introduce and 
explain skills where they would naturally fall into a real 
project workflow. 

The project-based approach in The Professional 
Portfolio Series allows you to get in depth with the software 
beginning in Project 1 — you don’t have to read several 
chapters of introductory material before you can start 
creating finished artwork. 

Our approach also prevents “topic tedium” — in 
other words, we don’t require you to read pages and pages 
of information about text (for example); instead, we 
explain text tools and options as part of a larger project. 

Clear, easy-to-read, step-by-step instructions walk 
you through every phase of each job, from creating a new 
file to saving the finished piece. Wherever logical, we also 
offer practical advice and tips about underlying concepts 
and graphic design practices that will benefit you as you 
enter the job market.

The projects in this book reflect a range of different 
types of print design jobs using Adobe Illustrator, 
Photoshop, and InDesign. When you finish the ten 
projects in this book (and the accompanying Portfolio 
Builder exercises), you will have a solid foundational 
knowledge of the three most popular applications in the 
print design market — and have a substantial body of 
work that should impress any potential employer.
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0 Combined Brochure

o Controlling Color 
for Output

o Working with 
Linked Files

o Fine-tuning Text
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 9 HeartSmart Newsletter

o Working with 
Templates

o Working with 
Styles

o Working with 
Tables

o Preflighting 
and 
Packaging  
the Job
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 8 Festival Poster

o Building Graphic 
Interest

o Importing and 
Formatting Text

o Graphics as 
Text and Text as 
Graphics

o Outputting the 
File
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 7 Letterhead Design

o Setting up the Workspace

o Creating Basic 
Page Elements

o Placing External 
Images

o Creating and 
Formatting Basic 
Text 

o Printing 
InDesign Files
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